Instruction Manual for the Nuclear Medicine Written Directive Manager
Background
The Nuclear Regulatory Commission requires that a "Written Directive" be created for any Nuclear Medicine therapeutic procedure or any procedure that uses greater than 30 microcuries of I-131. (10 CFR - Part 35.40 Written Directives). It is also a requirement that such directives be maintained for 3 years.

The written directive is essentially a prescription for any Nuclear Medicine therapy or any use of I-131 above 30 microcuries. These prescriptions may need to be viewed by many staff members at several points prior to the actual performance of the therapy. For example, a scheduler might be required to ensure that a written directive is in place prior to confirming an appointment date. A technologist or manager might require the directive to place the order for the therapy in the correct amount. The technologist in the "hot lab" will receive the radiopharmaceutical. Finally, the patient's identity is confirmed, pregnancy status is checked if needed, and the dose is finally administered.

Documented procedures are also required by the NRC (10 CFR - Part 35.41 Procedures for Administrations Requiring a Written Directives). This procedure must be kept by the licensee for the duration of the license.

If hard copy paper is to be kept and filed as a record of all individuals who participated in the written directive, it may be difficult to ensure that all involved individuals have completed their part of the process or retrieve the information. Paper forms for written directives can be lost leading to regulatory violations or a delay in patient care. In some cases, duplicate directives may be created by different authorized users leading to confusion in therapy amounts.

Clearly, a well defined process to simplify record keeping and streamline the flow of information from the initial creation of the directive through its completion would provide a structured procedure, simplify patient care and help ensure regulatory compliance. All of this and more can be managed using the Written Directive Manager for Nuclear Medicine.

The Written Directive Manager
The Written Directive Manager for Nuclear Medicine is a centralized database and archive that allows for elimination of paper while at the same time maintaining a trail of accountability from the time of directive creation through completion. The database can be kept in a single network accessible location allowing multiple individuals to each perform their task in the process without searching through papers or binders for specific directive sheets. Arranged in an intuitive tabular format, features of the Written Directive Manager are as follows:
A Defined Process
The Written Directive Manager will guide the users through a well defined set of steps for each directive to be completed. Each step must be completed prior to continuing to the next.

Initial Entry
Only an authorized user can create a new directive. After entering the patient name and information, a type of directive is chosen. This will auto-populate the needed fields containing the isotope, chemical form and route of administration. The default dose for each type of therapy can be left at zero, or auto-populated with a default amount that the authorized user can choose. Select a referring physician from a drop down list, choose a diagnosis, write a short note about the patient and treatment, and then save the directive. That directive immediately becomes available to anyone else who is using the software and is connected to the same database.

Scheduling
The scheduling of a directive can be performed by anyone who is given access to the database and software. The schedule screen provides a calendar of several months ahead, a list of holidays, and a listing of upcoming therapy appointments. An additional schedule wizard provides even more data on prior directives for the selected patient, therapies on the selected date, and a listing of active therapies that can be filtered by type.

Ordering and Receiving Radiopharmaceuticals
Like scheduling, documentation that the radiopharmaceutical has been ordered/received can be done by anyone who is given access to the software. The tab auto-populates with the radionuclide, the chemical form, and the prescribed dose. Whoever is ordering the radiopharmaceutical needs to confirm that they have verified the patient ID, the radionuclide and the chemical form is correct, and that the appropriate dose is verified. Whoever receives the radiopharmaceutical then enters the date that they received it, the actual dose that was received, and the lot number.

Verification of Patient Data
Confirmation of the patient identity is an important part of the written directive, and the person completing this tab must document two verification methods. If the patient is female, a pregnancy test question will be asked. The user then can either enter the reason that a test is not required or enter the date, type of pregnancy test and the result.

Completion of the Directive
Like the creation step, the completion of a written directive can only be performed by an authorized user. The tab will display the radionuclide, chemical form, dose received and the prescribed dose. The actual dose that is given needs to be entered by the authorized user and will display a difference from the prescribed dose along with a percentage difference. At any time that the actual dose given differs from the prescribed dose by greater than 10% an explanation for the variance is requested.

Standard radiation safety questions are also part of this section. These include confirmation that the authorized user has checked the patient's living and working conditions, assurance that the patient or care giver has been provided with radiation safety instructions and verification that the authorized user
has given consideration to the estimated dose of radiation that might be received by the patient's family or care givers. The final disposition of the patient (inpatient or outpatient therapy) is chosen along with the date that the therapy was performed. The authorized user then enters their password and the directive is completed.

Changes can be made to the directive at any time until it is completed by the authorized user. No changes can be made to a completed directive.

**Printing**
A paper copy of the directive can be printed at any point in the written directive process.

**Patient Information Document Repository**
Radiation precaution information frequently needs to be given to the patient either before or after a treatment is performed. A repository of information documents can be easily accessed through the software. Samples of such documents are provided with the software. The user may choose to create and customize their own documents. All documents should be in PDF format and are located in a directory called DOCUMENTS in the same directory that the database is located.

**Security**

**Creation and completion**
Just as only a physician can write prescriptions, only an authorized user is able to create a written directive. This security is maintained through a "electronic signature" with a password that allows only authorized users to create and complete the written directives.

**Networkable**
The database can exist on a shared directory making it available to all who need it. Using the built in Windows networking security, read and write permissions to the shared directory can be set to allow only those users who need access to the written directives network location. Contact your information technology professional with assistance in this configuration.

Digital data is valuable and it is HIGHLY recommended that regular back up procedures be performed so that in the event of file corruption or disk crash, a recent version of the database can be used to replace the lost version.

**Flexibility**

**Workflow**
In the event that several different individuals will access the software, the workflow can be customized to their particular duties. In most cases, choosing "1 - All Active Directives" will provide the most flexibility. This will show the user all directives that are not yet completed. If a user only wants to view the patients that need to be scheduled, they can choose "2 - Schedule". Other options for work flow can also be chosen.
**Multiple Written Directives**

Some types of therapy may require multiple directives to be created for a course of treatment for the patient. Up to six directives can be created from an existing directive. This simplifies the creation process so that demographic data, radiopharmaceutical, referring physician and history need only be entered once. The default dose is always set to zero in this case and the therapeutic dose needs to be adjusted individually.
Requirements for Use

1. A computer running the Windows® operating system versions 7, 8 or 10. Other versions may function but are not supported.
2. A monitor resolution of 1024 x 768 or greater.
3. 10 MB of disk space minimum for installation. Database requirements for space will increase over time depending on usage.
Detailed Use

Initial Screen and Layout

The Written Directive Manager is arranged in several discreet sections.

- The top menu bar is similar to all Windows programs.
- Icons located below are available for frequent functions.
- Tabs are sequentially arranged according to work flow for each therapy patient.
- Tabs do not become active until the previous tab has been completed.
- The upper right corner contains a drop down box that contains the databases used to hold the directives. Each institution or satellite can have their own completely separate database.
- In the lower right corner, the listing of patients is displayed according to the workflow that is chosen.
Entering a New Patient

After entering a medical record number, click find patient. If the patient has been treated previously, their demographic information will appear. If not, you will be asked to add them to the database.

Medical record numbers can be up to 12 alphanumeric characters in length.
Entering Patient Information

Enter the patient information and click the save button. The patient information will be entered into the database and appear in the "Find Patient" box near the top of the form. The screen will update and you will now be able to create a directive for this patient.
Create the Directive

Choose the options for this patient. Several predefined directives are already loaded. If these do not fit your practice, you can remove them or add more. Your frequent referring physicians can also be added to the database so that they can be selected from a drop down. A variety of common diagnoses are also included. Modification of these can be accessed at any time by selecting the "Tools" from the menu and selecting "Database" and one of the databases that are displayed.

Once all fields are completed, click on "Save Directive". Only an authorized user can create a directive. Once this is done, your patient will appear in the list of patients in the lower right corner of the screen. If you do not see the patient, change the workflow to "1 - All Active Directives". The next time you select the patient from the list, it will automatically open the next step in the workflow. In this case, the next time you click on this patient the user will be taken to the scheduling screen.
Schedule the Patient

Choose the date for the therapy. The calendar will show in bold the dates that are listed as holidays. Holidays can also be added or removed using the database modification options described earlier.

If there are any other therapy procedures scheduled, they will be listed in the box below. The schedule wizard will provide even more information on other scheduled therapies and prior therapies for the selected patient.

Enter initials in the space provided and schedule the patient by clicking "Save". The lower right patient selection list will update.

The next time you click on this patient, you will be taken to the order screen.
Order the Radiopharmaceutical

The radionuclide, chemical form and the prescribed dose are displayed. The user then confirms that the patient ID is verified. The radionuclide, chemical form and dose is verified. The user enters their initials and then chooses "Verify Order" to confirm that the therapy dose has been ordered.

The next time the patient is selected from the list, the user will be taken to the receive screen which is on the same tab.
Receive the Radiopharmaceutical

Once the radiopharmaceutical is received, the amount of the dose is entered along with the lot number and the date that it is received. The user enters their initials and selects "Received".

The next time the patient is selected from the list, the user will be taken to the verification tab.
Verify Patient Data

Confirm that the patient was identified using two patient identifiers. If a pregnancy test is needed, enter the result, the type of test and the date the test was performed. If a pregnancy test is not needed (not shown) the user will be asked for a reason.

The user enters their initials and clicks "Save". The next time the patient is selected, the user will be taken to the complete directive tab.
Complete the Directive

The actual dose given is entered. This generates a display of the difference from the prescribed dose and a percent difference from the prescribed dose. If the percentage difference (higher or lower) exceeds 10%, an explanation is required for the dose modification.

Radiation safety questions are confirmed and the final disposition of the patient (inpatient or outpatient) is selected. After the date of the procedure is confirmed, the authorized user is chosen from the drop down and enters their password. They then click on "Complete Directive", and the directive is permanently filed in the database.

Previous completed directives can be viewed by choosing the appropriate work flow.

A completed directive cannot be modified.
Patient Information Documents

Choosing patient information from File -> Patient Information on the menu or the icon from the toolbar will bring up a directory of document. This is the directory called "Documents" that you created during the install. Double clicking on them will open the document. You can place any PDF type document in this directory for convenient use. Examples include radiation precautions for various doses or forms that you might use when meeting with a patient and/or family.
Printing a Directive

If a paper record is ever needed, a directive can be printed out at any stage of its completion by choosing print from the menu or the printer icon from the toolbar. A directive must be selected before printing will occur.
Deleting a Directive

Should you ever need to delete a directive, select the patient from the list on the right, select the authorized user from the drop down and enter the password. Click on "Delete Directive" to permanently delete this directive. Only directives that have not yet been completed can be deleted. Only authorized users can delete directives.
Creating Multiple Directives

For some types of therapy, you might expect to treat the patient several times. New directives can be created from an existing directive by selecting File -> New Directive -> New From Current. You can also do this by selecting the appropriate icon from the toolbar. This will give you an opportunity to copy the directive up to six times using the same referring physician, diagnosis, notes, radionuclide and form. The dose will need to be individualized for each directive that is created.
The Scheduling Wizard

The scheduling wizard can be opened for any active directive. It will list any prior directives for the patient, any therapy that is scheduled on the selected date, all planned upcoming therapies and a listing of therapies that can be listed by type. If the patient is scheduled, an "I" or an "O" is added at the end of the name indicating if the patient is scheduled for an inpatient or outpatient therapy. A listing of holiday dates is also available to remind the user when a therapy might overlap a holiday.

Selecting the scheduling wizard can be done from the scheduling screen. Select the scheduling wizard from Tools -> Schedule on the menu bar or through the icon on the toolbar.

If the schedule tool is selected without an active patient, a similar screen will be shown with the exception of prior directives for a given patient.
Patient Family Dosimetry

Iodine-131 Release Estimate

You may need to estimate the potential exposure to family members. Enter the percent thyroid uptake and the prescribed activity of I-131. Select the patient thyroid status and the occupancy factor that you have determined for the patient situation. The half life of iodine in the thyroid is estimated at 7.3 days. This value can be changed as well as the average distance to be maintained from the patient. The calculation will determine an estimated exposure to a family member that meets the entered criteria.

This calculator is only an estimate of the actual activity that a family member might receive. These values are NOT stored with the directive and are only used for modeling purposes. Excellent links to comprehensive resources on the internet are provided in the lower left hand corner. These resources are not associated in any way with MedAssist Software and are provided only for informative purposes.
If a model for exposure is desired using a different isotope, the emission based calculator can be used. After selecting an isotope, determine the mr/hr at 1 meter and estimate an occupancy factor. Click on calculate and a total dose is displayed. The dose calculated is likely the largest that could be possible to any family member given the conditions entered. This is because there is no provision for biological excretion of the tracer. The calculation assumes that ALL of the administered dose remains inside the patient for the entire time that the isotope is radioactive.

In most cases this is an unlikely scenario, but it can be used to estimate the upper possible limit that a family member could receive.
Access Log

All access to the database is logged listing the medical record number, the date and time, and the login ID of the computer that software was running on at the time. If data was saved or changed, the user initials (or name if it is an AU) are also logged when saving data. This list can also be printed if needed.
Uncomplete a Directive

On discovering a serious error the authorized user might need to correct their mistake. This process should not be used routinely and every care should be taken that a directive is complete and correct prior to completion.

The uncomplete function cannot be done by an authorized user listed in the database and can only be done by the administrator of the software (WHO SHOULD ALSO BE AN AUTHORIZED USER). Enter the name ‘admin’ in the authorized user space and the password. This will return the directive to the state immediately before completion.

The password is the password you initially changed for the user name ‘admin’ when first installing the software. (Provided you followed the instructions)

**IMPORTANT:** Recognize that in this uncompleted state, a directive can now be deleted. This would have the effect of removing all evidence of a therapy that has been completed and is not likely to be viewed favorably by any State or Federal licensing authority.

Use with EXTREME CARE. You have been warned.

Copyright 2016 Robert H. Wagner, MD, SC
Version 07092016
Included in this version of software is an option to configure to connect to a GE Centricity™ Radiology Information System (RIS) database. You will need to know the IP address, username and password to connect to the database. Enabling this feature will allow you to enter a medical record number and search that database to retrieve the name, age, sex and date of birth of the patient.

Caution: This may not work with all versions of Centricity™ RIS. Be sure to contact your RIS administrator if you want to try and enable this function.
Database Entry Modifications
There are several databases that can be modified by the user to change the information that is displayed. Types of directives, referring physicians, various diagnoses and authorized user management can all be performed. Holidays can also be added or removed from the holiday list. Once holidays are past, they no longer show up in the schedule listing.

Multiple Directive Databases

To accommodate a variety of practices, the written directive software will allow the use of multiple databases. For example, an authorized user who keeps their data on a laptop and services different institutions may choose to keep a different database for each institution. An institution with multiple satellites that perform therapy at several locations may choose to have the databases located on a shared drive of a server. Using that model, the satellite database can be accessed from any location by choosing a database from the dropdown.

Each of the databases can be customized with referring physicians, common therapy procedures, and other information.
Security
The database is encrypted with a password to prevent users from corrupting the structure or content. Only the Written Directive Manager software can access the database.

IMPORTANT: The Written Directive Manager database is a collection of patient data and should always be well protected. Your State or Federal regulators will not be forgiving in the event that your data is lost. Please do not risk loss of all data through a hard disk crash. Back up your data, or better yet have your systems administrator do it automatically.

Conclusion
The Written Directive Manager for Nuclear Medicine is designed to provide a structured process and a permanent repository for written directives. We hope that this software tool eases the administrative burden of paperwork for you. We welcome any comments or suggestions.

Robert H. Wagner, MD, MSMIS
rhwagner@MedAssistSoftware.com

Disclaimer:
All patient names, dates, and medical record numbers in this document are purely fictional. Any resemblance to actual patients, living or dead or patient information is entirely coincidental.